
 

 

 
 

PILOTO DE GUÍA PDF (versión 1.17) 
 
Bienvenido a la Guía de Vyzex PocketPOD. Recuerde por favor que vuelva a la página web de Line 6 
(Www.line6.com) para las actualizaciones del programa y del presente documento. 
 
¿Cuáles son los requisitos mínimos para el programa? 
PC con Windows XP y Vista. 
 
NOTA: Windows 2000 no incluye un controlador de clase compatible MIDI, por lo que el Windows 2000 
sistema operativo no es compatible con Pocket POD. 
P4 procesador equivalente en adelante, gráficos en color de 32 bits y pantalla de 1024x800 o mayor. 
 
NOTA: Si la resolución de pantalla de su PC principal está cerca del requisito mínimo, es posible que 
necesidad de establecer la barra de tareas de auto-ocultar el fin de evitar la saturación del editor de interfaz 
gráfica de usuario por el sistema operativo Windows. 
 
MAC OSX 10.4 y OSX 10.5, Power PC G4, G5 y los procesadores de Intel. 1024x800 o mayor pantalla. 
 
¿Cómo instalar y configurar el programa? 
En primer lugar se debe ejecutar el programa de instalación, entonces usted debe conectar su Pocket POD a su 
equipo con el cable USB, fuente de alimentación a Pocket POD con pilas o con un nivel de Line 6 POD poder 
suministro, y conectar un cable de la guitarra a la entrada de Pocket POD. Este último paso es importante, 
incluso si usted no tiene una guitarra conectada en el otro extremo, desde la toma de la guitarra en Pocket 
POD actúa como un interruptor on / off. 
   

Los siguientes puertos USB son conocidos por causar Pocket POD para restablecer de forma 
espontánea sus conductores y reiniciarse cuando se accede por conectados software MIDI: 
   
   Todos los Hubs USB incluidos muchos puertos USB integrados en ordenadores portátiles, 
   Mac Torre: El puerto USB frontal 
   Macbook: La parte posterior (izquierda), puerto USB 
   MacBook Pro: El derecho de los puertos USB 
 
¡Asegúrese de que su POCKET POD se conecta mediante un puerto USB FIABLES antes de continuar! 
¿Todo lo marcado en la lista anterior? Muy bien! Ahora debes cerrar cualquier puerto MIDI usando el 
software de música que se estén ejecutando antes de ejecutar el programa por primera vez - Esto evitará 
posibles conflictos entre Vyzex y el otro software de MIDI en el viaje inaugural del programa. 
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Auto-sensing, auto-sensing, 1, 2, 3… (detección automática, 1, 2, 3 …)  
 
De forma predeterminada, Vyzex PocketPOD abrirá cada MIDI en este lugar y puerto de salida MIDI en el 
ordenador y realizar una búsqueda minuciosa de su PocketPOD: Cuando PocketPOD se ha encontrado, Vyzex 
establecerá el MIDI IN y MIDI puertos de salida que necesita para comunicarse con PocketPOD 
automáticamente. 
De forma predeterminada, Vyzex PocketPOD automáticamente GET (upload) de edición de bank (banco) de 
su PocketPOD de usuario y la actual tampón cada vez que inicie el programa: 
   
 

 
 
Este paso asegura que el editor tiene una copia de cada bank de memoria de canal a bordo de su PocketPOD 
carga para la edición en el inicio de cada sesión. 
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Una vez que se complete la transferencia podrá hacer clic en el botón de modo de "BANK" y ver todo el canal 
Bank (banco) de su PocketPOD dentro de la interfaz gráfica del editor de usuario,  Graphical User 
Interface (GUI): 
 

   
 
En este momento, el editor y su PocketPOD están completamente sincronizados. Esto significa que tanto el 
software y el hardware se han cargado los datos idénticos y todos los cambios que realice en el editor de forma 
automática transmitido a su PocketPOD, incluyendo cualquier cambio en el Banco de canal con el pedido. 
 
Backing Up Your Tone Data (Copia de seguridad de datos de tono) 
 
Para hacer copias de seguridad de los datos de tono en el disco duro, seleccione "FILE->Save Set" en el 
menú de la aplicación. Ahora está una copia de seguridad, siempre y cuando no guardar los cambios en este 
archivo. Si usted está preocupado acerca de que eso ocurra, puede también elegir la opción "FILE->Save Set 
As…" comando de menú para cambiar el nombre del archivo que está trabajando antes de seguir adelante. 
 
¿Qué pasa si tengo un mensaje de error diciendo que el editor no puede encontrar mi PocketPOD? 
Si el software de edición no es capaz de encontrar su PocketPOD y sincronizar sí, usted tiene un problema de 
conexión. 
- Suponiendo que ha seguido el esquema de conexiones MIDI en la página 1, este problema es probable que el 
driver de Windows relacionados. Por favor, echa un vistazo a la solución de problemas Vyzex PocketPOD 
archivo PDF, disponible para acceso instantáneo en el menú del programa Manuales. 
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Bueno, hice una copia de mi archivo de conjunto para la seguridad. Entonces, ¿cómo puedo editar un canal 
PocketPOD? Simplemente gire las perillas y haga clic en el menú emergente controles en el editor de interfaz 
gráfica de usuario Vyzex y escuchará los cambios reflejan instantáneamente en PocketPOD:  
Estos cambios serán temporales a menos que usted pulse el botón STORE en el editor de interfaz gráfica de 
usuario.  
 
He aquí una breve gira por algunas de edición con Vyzex PocketPOD: 
 

 
 

 
TONE EDIT (TONO DE EDITAR) 
Pulse TONE(TONO) para poner el editor de GUI(interfaz gráfica de usuario) en tono modo de edición. 
 
Editar los parámetros girando las perillas y haciendo clic sobre el texto controles en el editor de GUI (Véase 
NOTA más abajo). 
 
Cuando se recibe una sonido que desea guardar, pulse el botón STORE(TIENDA) para sobrescribir el tono 
original en la ubicación del banco se indica al lado para el canal NAME en el editor GUI(Interfaz gráfica de 
usuario). 
 
En el modo funcionamiento normal, el editor también se actualizará el correspondiente canal de memoria a 
bordo su PocketPOD siempre que presiona el botón STORE en el editor de GUI. 
 
Ahora vamos a hacer clic en el EDITOR MODE BANK botón para cambiar TONE(TONO) modo de edición 
de BANK el modo de edición. 
 
NOTA:  
Los mandos funcionan como controles giratorios y arrastre: Usted puede cambiar a operar como arrastrar 
lineal 
controles en el cuadro de diálogo Options->Preferences. Una explicación completa del programa 
preferencias y una visión general de cómo todos los tipos de control de funcionamiento  (que incluye un 
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teclado-corto cortes y modos alternativos clics) se puede encontrar en las preferencias Guía PDF, disponible 
desde el menú de la aplicación de manuales. 

 
BANK EDIT (Edición de banco) 
Con la edición de banco el modo activado, puede ver todos user chanel en el CHANEL BANK(CANAL DEL 
BANCO). 
 
Si hace clic en cualquier inscripción en el CANAL DE BANCO zona en la que dará cuenta de que es 
automáticamente cargado el tono edición. También saber que el nuevo tono también se está escuchando en su 
PocketPOD. 
 
Usted puede arrastrar y soltar las entradas en el banco de canales de intercambio a su alrededor. 
 
También puede copiar uno o varios canales consecutivos entradas a la portapapeles y luego pegarlos en un 
ubicación diferente, siempre que el destino es el mismo tamaño que la de origen. 
    
Arrastre y suelte las operaciones en la labor de editor CANAL DEL BANCO de la siguiente manera: 
   
   Si arrastra cualquier preset en el banco a otro lugar, los presets de origen y destino cambiarán de lugar. Se 

trata de una operación de swap. 
   Si mantiene presionada la tecla CTRL (Opción en Mac) mientras arrastra y suelta, la fuente se copiará 

sobre el destino. Se trata de una operación de copia. 
   Si mantiene presionada la tecla Mayús mientras arrastra y suelta, la fuente se trasladó a la lugar de destino 

y las entradas del banco entre los dos se desplazarán de nuevo un lugar con el fin de llenar el agujero dejado 
por la fuente. Se trata de una operación de inserción. 

 
Cada cambio que realice en el banco de canales a través del editor de interfaz gráfica de usuario será 
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automáticamente transmitido a su PocketPOD, a fin de recordar a restaurar el usuario original guardado 
establece en su PocketPOD cuando haya terminado jugando con el editor. 
CAMBIAR EL NOMBRE DE UN TONO 
Simplemente haz clic en el tono actual del nombre para cambiarlo ... 
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EL “STORE IN” BOTÓN 
 
El tono es cambiado de nombre, y decidir que nos gustaría guardar el cambio - pero no en el 1ª ranura dentro 
del editor de canales bancaria:  
Queremos que el “5 Shades of Blue” tono que se encuentra en el Banco de canal 6C de memoria en su lugar. 
En lugar de hacer clic el botón STORE, haga clic en STORE IN botón, en su lugar. 
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THE ‘STORE IN’ DIALOG 
The store in dialog le permite elegir la ubicación en el banco de canales como un destino. 
Elijamos como 6C el destino. 
A continuación, haga clic en el botón The store in dialog. 
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PASO 6: 
Si ahora miras en CHANNEL BANK área del editor, verás que 6C canal de memoria contiene el tono hemos 
llamado “5 types of glue“. 
En este punto, el 6C canal de memoria en su PocketPOD será también ahora contienen los "5 Types 
of Glue". 
Se habrá dado cuenta de que el original de “5 SHADES OF BLUE” en el canal 1A memoria no ha cambiado. 
En la parte superior de la interfaz gráfica de usuario, puedes encontrar que 6 C es ahora muestra como el Banco 
de Canales ubicación de la “5 types of glue" que en la actualidad carga para la edición: 
Si usted presionase ahora el botón STORE, el tono se almacenaría en el 6C destino. 
     
Nice Demo. Ahora, vamos a recuperar los datos originales de mi PocketPOD - I’m jamming 
tonight! 
Si ha seguido a lo largo y experimentado con el botón STORE o realizado cualquier tipo de banco las 
operaciones de reorganización, debe tener en cuenta que cada cambio que acaba de hacer en el editor también 
ha sido aplica automáticamente a las posiciones de memoria a bordo de su PocketPOD. 
Para restaurar la memoria a bordo de su PocketPOD a su estado original, siga estos pasos: 
   
1. Seleccione Select File->Open en el menú del programa y seleccione el archivo *. SQS (juego) archivo 
que originalmente guardado. 
2. Si un diálogo que le preguntará: “Do you want to save the changes?”(¿Desea guardar los cambios?) 
Haga clic en el botón “No“. 
3. Cuando el “Synchronize This Set?”(¿Sincronizar Este Juego?) de diálogo se abre, haga clic en el botón 
“SYNC the Set TO PocketPOD"(SYNC del Conjunto)a PocketPOD. 
Este procedimiento se cargará el archivo guardado en el editor de conjunto y sincronizar sus contenidos a su 
PocketPOD. 
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Tener el editor automáticamente sobreescribir mi banco PocketPOD cada vez que abro un archivo de 
conjunto hace que me ponga nervioso - Guardo mis tonos tocar almacenados a bordo de la unidad! ¿No 
hay una manera más segura para trabajar? 
Absolutamente: Hay momentos en los que no quieren sincronizar un archivo abierto en su conjunto PocketPOD, 
por ejemplo, cuando usted sólo desea ver el conjunto de archivos de tonos interesantes. En estos casos, tiene 
más 
sentido para el editor de la transferencia de cada tono que seleccione en el búfer de edición temporal a bordo de 
su PocketPOD, evitando la PocketPOD Canal del Banco en conjunto. El resultado es su PocketPOD 'juega' lo 
tonos que seleccionar a bordo, mientras que su canal Banco se mantiene sin cambios por el editor. 
Para entrar en este modo de funcionamiento alternativo, abra un conjunto de archivos desde el disco y haga clic 
en el botón “Do Not SYNC This Set File”(no se sincronizan este conjunto de archivos)  cuando el 
“Synchronize This Set?”(¿Sincronizar Este conjunto?) abrir diálogo: 
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Este "SAFER"(seguro) forma de trabajar se llama Virtual Bank de edición: En vez de canal de operación del 
editor Banco una copia completamente sincronizada del actual Banco de canal en su PocketPOD, el editor de 
Canal Bank opera como un "virtual" banco sin tener que tocar el Banco de canales en el PocketPOD. 
 
Para explicar la diferencia entre el directo y la edición virtual del Banco, aquí es una representación gráfica de 
la 
tres niveles que interactúan cuando se utiliza el editor Vyzex PocketPOD: 

 
Echa un vistazo a la caja roja POCKETPOD derecho de la izquierda: ¿Ver las 124 plazas verdes dentro de la 
caja roja? Estos representan los 124 tonos de canal que están en el banco de canales a bordo de su PocketPOD. 
Ahora mira el cuadro titulado EDITOR negro en el centro de esta ilustración: Otro grupo de 124 plazas verdes, 
¿no? 
Estos representan los 124 tonos que están cambiando cada vez que se edita en el editor de bancos. 
 
En la ilustración anterior debe quedar claro que los tonos en los dos bancos de canales usualmente comienzan 
como copias de cada uno (por ejemplo, inmediatamente después de haber subido un SET para el editor de 
PocketPOD, o inmediatamente después de haber descargado un juego a que el editor PocketPOD). Cuando el 
editor funciona en Modo Direct Bank (directo del Banco), el software automáticamente las transferencias de 
los cambios que realice en el banco de canales del editor directamente a la orilla del canal en su PocketPOD. 
Este es el modo de funcionamiento normal del editor que es fácil de entender y fácil de usar. 
Por otra parte, cada vez que abra un archivo de conjunto desde el disco en el editor y no para sincronizar sus 
datos a su PocketPOD, le está diciendo al software que el Banco de canal en su PocketPOD no debe ser 
sobrescrito para que coincida con el Banco de canales en el editor. El software de edición de esta norma sigue 
cambiando a Virtual Bank de modo. 
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En el modo virtual del Banco, el software simula edición bancaria sin tener que integren el Banco del Canal 
en el PocketPOD. Cada vez que seleccione un nuevo preset en el banco de canales del editor, esto es lo que 
sucede: 
   
1. El editor envía un cambio de programa a su PocketPOD para actualizar la visualización del número de 
bancos en el del panel frontal, 
2. Las actualizaciones editor de la memoria intermedia de edición PocketPOD con los datos del tono 
seleccionado del editor.  
 
Como resultado, usted puede ser engañado en el pensamiento del banco del editor es en realidad el banco a 
bordo PocketPOD, pero es sólo una simulación convincente por parte del editor, y por eso llamamos a esta 
edición de la técnica banco virtual. 
 
En el modo Virtual Bank (Banco virtual) se puede navegar a través del Banco de canales en el editor y realizar 
todo tipo de reorganización de las entradas del banco mientras se arrastra nuevos tonos de entrada y salida de la 
colección (más en el Colección en breve) y su PocketPOD fielmente audición cada sonido seleccionado como si 
estos tonos se parte del banco PocketPOD a bordo - Lo importante a recordar es, a menos que específicamente 
comando el editor de la transferencia de su canal en el Banco de PocketPOD (con una operación manual SET 
SINC), el banco real a bordo de su PocketPOD está completamente protegido. Esto significa que sus sonidos 
tocar todo-importantes son seguros contra el borrado a menos que realmente quieras para reemplazarlos. 
 
Cuando el editor Vyzex PocketPOD está en modo de banco virtual, verá que un botón extra como 'SYNC' 
aparece directamente debajo de los botones de navegación USER CHANNELS(USUARIO CANALES) en el 
editor de interfaz gráfica de usuario: 
   

 
 
Además, un rojo intermitente "V" indicador (V de Virtual no, Vendetta) también aparece entre STORE y 
STORE IN botones en el modo virtual del Banco. Esta es su señal de que la edición virtual del Banco está 
comprometido. 
 
Los botones STORE y STORE IN sólo escriben en el canal del Banco del editor cuando el indicador de la 
"V" comience a parpadear, dicho sea de paso. Este el Banco Canal salvaguardias a bordo de su PocketPOD 
como parte de ñas reglas de funcionamiento del Banco Virtual. 
El botón SYNC ofrece una forma de comando del editor para restaurar la sincronización entre su PocketPOD 
a bordo de banco de canales y el banco de canales en el editor. También ofrece la opción de sincronizar la 
corriente tono que se está editando en el Banco PocketPOD Canal desde el modo virtual del Banco. Al hacer 
clic en el botón SYNC lanza el siguiente diálogo: 
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Este cuadro de diálogo le permite elegir entre cuatro diferentes operaciones. De izquierda a derecha, son: 
   
1. SYNC Set TO POD: Esto transfiere todo el conjunto en el editor para PocketPOD, remplazando el Canal 
Banco a bordo del aparato y la reanudación de la edición de modo directo. 
2. SYNC Set FROM POD: Esto transfiere toda la Ribera del Canal desde su PocketPOD en la corriente 
conjunto de archivos y se reanuda la edición de modo directo. 
3. SYNC Channel to POD: Esto escribe el tono siendo editada en el editor para el banco que aparecen 
ubicación en el Canal del Banco, tanto del editor y su PocketPOD Canal Bank. Virtual del Banco de edición 
continuar. 
4. CANCEL: Este (obviamente) se cancela el cuadro de diálogo sin ningún tipo de cambios. Banco Virtual 
contunuará editando. 
 
Cuando Virtual modo de banco está activo, también dará cuenta de dos nuevos botones que aparecen en el 
editor de Banco siempre a hacer una selección: GET SELECTED y SYNC SELECTED. 
 

 
   
Estos dos botones de comando del editor para obtener ya sea la ubicación del canal correspondiente de su 
PocketPOD y cargarlo en el Canal del Banco del editor o para sincronizar la entrada seleccionada en el 
correspondiente canal de ubicación en PocketPOD. Estos dos botones no están disponibles fuera de modo 
virtual del Banco, ya que son innecesarias cuando el banco del editor del canal y el banco de canales 
PocketPOD son automáticamente sincronizados. 
 
Hasta ahora sólo he hablado de conjunto (SQS) archivos - ¿Qué pasa con los archivos de L6T 
CustomTone.com? 
Mientras que los archivos SQS son el formato utilizado por el editor Vyzex para almacenar el contenido de un 
PocketPOD todo en un lugar, el programa también trabaja con un solo canal de Line 6 tonos (L6T) los archivos 
disponibles para su descarga en http://www.customtone.com. 
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NOTA: L6T archivos vienen en muchas variedades diferentes: Una de Vetta II L6T archivo no será 
compatible con  PocketPOD hardware, ni un Pocket POD archivo L6T ser compatible con hardware para 
HD147  
ejemplo.  
 
Sólo PocketPOD, Floor POD Plus y POD 2.0 L6T archivos pueden ser abiertos por el Vyzex  
PocketPOD software de edición - Todos los tipos L6T otro archivo son incompatibles!  
 
Como se mencionó anteriormente, Vyzex Pocket POD puede importar Floor POD Plus y POD 2.0 archivos 
L6T. Vas a tener que tener en cuenta que estos dispositivos están cerca, pero no idéntica a PocketPOD en la 
estructura y que los importados archivo no puede sonar 100% como lo hizo en el dispositivo original, cuando se 
cargan en su PocketPOD.  
   

 
Al abrir un archivo L6T, el tono se carga para la edición como el tono seleccionado actual: Usted puede 
escuchar, pero a menos que lo almacene “STORE” para una ubicación de canal del Banco no se convertirá en 
una parte relativamente permanente del conjunto de archivos.  
 
¿Puedo arrastrar y soltar archivos L6T para importarlos?  
Sí: Puede arrastrar y soltar los archivos L6T desde cualquier carpeta abierta en el equipo en el editor de Vyzex 
PocketPOD ventana:  
   Si deja caer el archivo a través del área de edición TONO de la interfaz gráfica de usuario que se importarán 

a la actual CANAL búfer de edición (como se muestra en la ilustración de arriba),  
   Si deja caer el archivo a través del área de edición Banco de la interfaz gráfica de usuario que se importarán 

en el canal específico la entrada de bancos se cae dentro.  
   Si deja caer el archivo a través de la vista de colección (se explica en la página siguiente), que se importen 

en la recogida y ordenados alfabéticamente por el nombre. 
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¿Qué pasa con los archivos L6T múltiples?¿Puedo importar una selección de estos en una sola toma? 
Sí: Puedes lote de importación cualquier número de archivos en el editor de L6T Vyzex PocketPOD, pero 
tendrá que abrir la vista del editor primera colección ... 
 
Apertura de la vista de colección 
La vista de colección puede ser abierto por el control de la Collection View(Colección Ver tema) en el menú 
Options(Opciones): 
  

 
 
 
La colección actúa como una lista global de sus tonos favoritos que sigue estando disponible sin importar el 
conjunto de archivos usted tiene actualmente abierto. Esta propiedad hace que la vista de colección como 
igualmente útil como una transferencia portapapeles y una biblioteca principal de los componentes del set. 
 
Para importar cualquier número de archivos L6T en la colección, sólo tiene que seleccionar los archivos L6T en 
una ventana de la carpeta abierta y a continuación, arrastre y suelte la selección en el panel de Recaudación de 
la ventana del editor. La próxima vez que abra el Colección Vista podrás ver estos tonos han sido ordenados 
alfabéticamente en la lista de colecciones. 
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Para transferir la entrada de bancos a la Colección, basta con arrastrar desde la ventana del Banco en la 
Colección. Del mismo modo, para transferir una entrada de la colección al editor, basta con arrastrar de nuevo 
en el editor. Si desea copiar el tono en la actualidad ha editado para la colección, mantenga presionada la tecla 
ALT y haga clic en el botón del ratón sobre cualquier zona de el editor, donde no hay un control (como el 
logotipo de la línea 6) y ALT y arrastre el tono de la colección. 
 
A diferencia de la opinión del banco (que se carga automáticamente cualquier selección realizada para la 
edición), la colección que permite a la audición de su selección sin que carga directamente en el editor de 
interfaz gráfica de usuario. Esto significa que usted puede escuchar cada tono en la colección por medio de un 
solo clic sobre ellos a su vez, pero su actual edición no se verá afectado. Si en realidad desea reemplazar el tono 
en la actualidad ha editado con uno de la colección, simplemente haga doble clic en el tono que desea cargar. 
 
Hay un par de reglas que rigen las operaciones de arrastrar y soltar que son posibles entre la Colección 
y el GUI Editor, y nos pondremos en ellos más adelante, cuando cubrimos el GUI Editor en mayor detalle. 
   
 NOTE: Usted no tiene que arrastrar un elemento de la colección en el editor si solo desea para escucharlo: 
Cuando suceda, hacer clic sobre el tema Vyzex automáticamente se carga en el buffer de edición PocketPOD 
para audiciones instantánea. Si usted decide que usted también desea modificar cualquier elemento de la 
colección en el editor de interfaz gráfica de usuario, simplemente haga doble clic en él y se carga para la 
edición y ser oídos al mismo tiempo. 
 
Cuando instale por primera vez Vyzex PocketPOD, la colección estará vacía. Luego, cuando se agregan 
elementos a la misma desde el Editor de la colección se almacena de forma secuencial, lo que significa que las 
entradas más recientes siempre se encuentran más cerca de la parte inferior del listado de la colección: Esto le 
permite archivar varias versiones del mismo tema y no preocuparse de cuál es la más reciente. 
   
  NOTA: La colección completa se almacena en un único archivo en el disco duro, Default.SQC: Si 
quiero volver a archivar la colección, este es el archivo de copia de seguridad. 
El archivo Default.SQC se encuentra en el \Psicraft\Vyzex PocketPOD\Line 6 PocketPOD 
subcarpeta de la carpeta de documentos de usuario (en Windows y Mac). 
 
  ¿Qué pasa con la BANDA ESTILO y tonos en mi PocketPOD: ¿Cómo puedo poner esto en la colección? 
Dado que la colección es un lugar conveniente para usted para mantener los tonos útil, es posible que desee 
transferir número de los tonos predefinidos de BAND PocketPOD o bancos ESTYLE a la colección. Aquí está 
cómo hacerlo: 
   
1. Abrir la vista de colección en el menú ‘Options->Preferences’ menu. 
2. Chose ‘File->Open‘, Abrir "del menú de la aplicación Vyzex PocketPOD. 
3. Seleccione la opción "Band.SQS” archivo que se instala con el software de edición - Un conjunto se abrirá 
que contiene PocketPOD de selección completa de los bancos BAND. 
4. No sincronizar el conjunto de su PocketPOD cuando se le solicite por el Sync This Set('¿Sync Este 
conjunto?)’ Diálogo. 
5. Acceda al modo de Bank del editor y seleccione los tonos que desee en el editor de bancos. 
6. Arrastre estos tonos en la Colección y suelte el botón del ratón. 
7. Volver al paso 2 y repita con el archivo 'Style.SQS' que se instala con el software de edición. 
 
  NOTE: Usuarios de Mac - Los archivos Band.SQS y Style.SQS se encuentran en la 
'Macintosh HD: Documentos: Psicraft: Vyzex PocketPOD: Línea 6 PocketPOD' carpeta, 
donde 'Macintosh HD' es el nombre de la raíz de su disco duro de sistema operativo. 
 
Con esto concluye el piloto Vyzex PocketPOD Guía del manual en formato PDF ... Fue bastante rápido, ¿no? 
Desde este documento es sólo una introducción, es una buena idea para que usted lea también los manuales de 
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compañía como PDF la Vyzex PocketPOD Preferencia Guía y el Vyzex PocketPOD Guía para resolver 
problemas de más visión completa de cómo funciona el editor. Al igual que en este PDF, estos archivos PDF 
son también accesibles desde el Manuales programa menú desplegable. 
 
ANEXO 1: Configuración manual de PocketPOD Vyzex 
 
Como se mencionó en la primera parte de esta guía del piloto, Vyzex PocketPOD se configura automáticamente 
para utilizar el corregir los puertos MIDI y luego sube banco PocketPOD de usuario y canal de tampón cada vez 
que inicie la del programa. Si bien esta es la configuración por defecto para el programa, usted es libre de 
volver a configurar el programa manualmente que pueden ser más a su gusto una vez que haya dominado la 
forma en que opera. 
 
Hay cuatro opciones básicas que se activan en el programa como predeterminado: 
   
    Auto Juegos de carga: Cuando está activado, las cargas Vyzex un conjunto de PocketPOD cada vez que se 

inicia el programa. 
    Detección automática de Programa de Ejecución: Cuando se activa, automáticamente Vyzex trata de 

determinar la Puertos MIDI y el canal SysX de comunicación que utiliza cada vez que se inicia el programa. 
Si este opción no está activada, debe configurar manualmente la configuración utilizando el cuadro de diálogo 
Configuración. 
    Carga automática temporal Elementos cuando Crear Nuevo Juego: Cuando está activado, las cargas Vyzex 

un conjunto de PocketPOD cuando un archivo se crea uno nuevo. 
    Guardado automático de sesión y Actualizar: Cuando se activa, Vyzex guarda automáticamente el conjunto 

a la salida del programa y vuelve a cargar esta serie la próxima vez que se ejecuta el programa. 
 
NOTA: Si la opción "Juegos de carga automática es también la inspección, la sesión de recarga no se llevará a 
cabo - un nuevo conjunto será cargada desde PocketPOD lugar. 
 
En lugar de simplemente mostrando lo que desmarcar, vamos a explicar los detalles del fondo, a partir de 
Geek Hechos 1 y 2 de la Guía del Midiot para el estudio: 
   

 
 
 
Geek Hecho # 1: Un cable USB es igual a muchos cables MIDI. Al conectar un cable USB entre un 
Interfaz MIDI y el ordenador en realidad se está conectando dos cables MIDI virtuales: Uno de 
salida PocketPOD a la entrada de la computadora y otro de salida del equipo MIDI 
entrada PocketPOD en una sola toma. 
 
Desde la perspectiva de su sistema operativo de la computadora, el cable MIDI virtual que viene de su 
PocketPOD aparece como un puerto de entrada MIDI y un puerto de salida MIDI. Estos puertos estarán 
disponibles paracualquier software de música compatible con MIDI, que incluye secuenciadores, Daws y por 
supuesto el Vyzex PocketPOD programa de edición. 
 
Geek Hecho # 2: computadoras con frecuencia tienen "ocultos" de puertos MIDI. Es cierto. Incluso si 
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usted no tiene otros Dispositivos USB MIDI conectado, el ordenador puede tener "virtual" puertos MIDI que 
cosas como la dirección puerto de la tarjeta de sonido de juego o que el chip a bordo cursi sintetizador que los 
sitios web mal amor al fuego de manera inesperada. Estos puertos MIDI siempre será visible para los 
programas de música como posibles selecciones en Además de los puertos que PocketPOD presenta el sistema 
operativo de su ordenador cada vez que el USB cable está conectado, sin importar su gusto en el diseño web. 
Hemos relacionado estos dos hechos geek para prepararse para el hecho de que antes de que pueda utilizar su 
PocketPOD con cualquier pieza de software de música, tendrá que seleccionar uno o más apropiado puertos 
MIDI IN y los puertos de salida MIDI dentro de los cuadros de diálogo de configuración del software. 
 
Como se mencionó anteriormente, Vyzex PocketPOD está configurado por defecto para realizar 
automáticamente esta tarea para usted cuando usted empiecen a usar el editor, pero después se hacen más 
expertos con su PocketPOD, es probable que desee hacer cosas más sofisticadas con él, y eso es cuando la 
información en esta sección de la Guía del usuario es esencial para que usted sepa. 
 
El MIDI Vyzex En diálogo Puertos (MIDI-> MIDI Puertos ... Menú) 
 

 
   
Los puertos MIDI IN DIÁLOGO SOBRE WINDOWS XP (con un puerto MIDI cumpla con la clase 
MUESTRA) 
Los puertos MIDI IN de diálogo le permite seleccionar el puerto MIDI (s) que desea que el editor de conectarse. 
Por defecto, el Always Start with All MIDI Ports Open('Siempre comienzo con todos los puertos MIDI 
Abrir') opción está marcada, porque esto permite que el AutoSense de rutina para comprobar todos los puertos 
MIDI que está disponible para su equipo. Si ha deshabilitado AutoSense en el Vyzex menú de preferencias, 
debe desactivar esta opción para evitar conflictos con otro software de música instalado en su computadora que 
es posible que desee ejecutar simultáneamente al editor Vyzex. 
 
Es importante entender que el sistema operativo de la computadora se refiere a estos puertos como puertos 
MIDI IN únicamente desde su propia perspectiva, no de PocketPOD ": Esto significa que el puerto MIDI IN 
llamada de audio USB El dispositivo está realmente conectado al puerto MIDI OUT PocketPOD, y el puerto de 
salida MIDI llamada de audio USB El dispositivo está conectado realmente con el puerto MIDI IN en 
PocketPOD. No te preocupes - Esto no es tan confuso como sonidos. Sólo recuerda que desde la perspectiva de 
la computadora, estos dos puertos son el puerto de entrada que trae Datos MIDI de los PocketPOD y el puerto 
de salida que envía datos MIDI a PocketPOD. 
 
Para la operación editor básico, sólo tiene que seleccionar cada puerto utilizado por PocketPOD. Estos serán 
etiquetados de acuerdo con el nombre de su particular interfaz MIDI, a menos que usted está usando Windows 
XP y la interfaz MIDI se cumpla con la clase (lo que significa que utiliza el incorporado en Windows el 
controlador USB MIDI). Windows XP las etiquetas de su clase compatible con puertos MIDI como algo hostil 
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"USB Audio Device" como se muestra arriba. 
 
NOTE: Recuerde: ¡Estas instrucciones sólo se aplican si va a configurar manualmente el software 
Vyzex! De lo contrario usted puede dejar todo como estaba instalado y el software automáticamente 
volver a configurar la entrada MIDI y los puertos de salida MIDI cada vez que se ejecute el programa. 
  
En Windows Vista y Mac OS X, los nombres de puerto MIDI son siempre mucho más amigable que Windows 
XP: En estos sistemas operativos se le podrá decir los puertos de la interfaz MIDI MIDI de los demás de que su 
sistema puede tener disponibles. Simplemente haga clic en el puerto para seleccionar y haga clic en el botón 
Aceptar: Sólo recuerde que si desea que el programa para recordar estas selecciones cada vez que se ejecuta 
también tendrá que desactivar la opción y ‘Always Start with All MIDI Ports Open’("Comenzar con 
todos los puertos MIDI abierta siempre"). 
 
El MIDI Vyzex Fuera de diálogo Puertos (MIDI-> Puertos de salida MIDI ... Menú) 
  

 
LOS PUERTOS MIDI OUT de diálogo en MAC OSX 

   
  NOTE: PARA WINDOWS XP 
Como se explicó anteriormente, Windows XP se refiere a MIDI PocketPOD en el puerto y puerto de salida 
MIDI como Dispositivos de audio USB, que puede llegar a ser muy confuso, especialmente si usted tiene más 
de una clase - USB compatible con el dispositivo MIDI conectado a su PC. En esta situación, el de dispositivos 
de audio USB están numeradas, y (por desgracia) el orden de los puertos de cada dispositivo se diferencian del 
modelo de 
modelo, así que esté alerta cuando se están tratando de determinar cuál (s) para seleccionarlo. 
 
Además de los puertos de salida MIDI de numeración para el Windows XP es a menudo diferente de la 
En el puerto MIDI de numeración, así que por favor tenga esto en cuenta al configurar los puertos MIDI 
manualmente. 
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Multi-cliente de compatibilidad de controladores 
 
En el mundo de los controladores de dispositivos MIDI, funcionamiento multi-cliente es muy deseable: Multi-
cliente controladores MIDI pueden ser abre y se utiliza por la aplicación de software más de uno en uno, 
permitiendo que múltiples programas para compartir adjunta dispositivos MIDI. Mientras que Apple OS X 
conductores MIDI compatible son multi-cliente, el equivalente 
controladores MIDI Microsoft clase compatible en Windows XP y Vista no multi-cliente: Esto significa que no 
sea capaz de utilizar Vyzex para editar su PocketPOD mientras que otro programa está accediendo a ella (como 
su aplicación de audio favoritos secuenciador o programa). 
   
   
 
NOTE: WINDOWS XP y Vista 
Si usted tiene la "Siempre comienzo con todos los puertos MIDI Abrir" opción activada para su uso con los 
Vyzex características AutoSense y tiene otros no multi-cliente de los dispositivos MIDI conectados, esto 
causa conflictos con cualquier otro software de MIDI que se están ejecutando. En esta situación, debe 
desactivar esta opción y configurar manualmente Vyzex para trabajar con su PocketPOD. 
 
Desactivación de la gestión automática del puerto MIDI (AutoSense) Característica 
Si tiene que deshabilitar la función de Detección automática, las opciones de programas pertinentes se 
encuentran en las preferencias diálogo dentro de la ficha Estudio: 
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                                       PREFERENCIAS DE DIÁLOGO - TAB ESTUDIO (WINDOWS XP) 
 
Basta con desmarcar la opción AutoSense se muestran a continuación, desactive la abra ‘Always Start with 
All 
MIDI Ports Open’ ("Siempre comienzo con todos los opción MIDI Puertos abiertos '), tanto en los puertos 
MIDI IN y MIDI a cabo diálogos de Puertos. Después de haber hecho esto el aplicación Vyzex ahorrará ningún 
específica IN y OUT selección de Puerto (s) que usted ha hecho. 
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